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About This Manual

This manual contains many techniques for using NI Vision Builder for Automated Inspection
(Vision Builder Al) to solve visual inspection tasks including inspection, gauging, part presence,
guidance, and counting.

Follow the instructions in this manual to familiarize yourself with Vision Builder Al and perform
common inspection tasks.

This manual contains the following chapters:

Chapter 1, Introduction to Vision Builder Al, introduces the Vision Builder Al environment
and describes how to run an inspection.

Chapter 2, Checking for the Presence of a Part, introduces the Match Pattern, Measure
Intensity, and Set Coordinate System steps. Follow the instructions in this chapter to
create an inspection that checks for the presence of a spray bottle cap regardless of the bottle
position in the inspection images.

Chapter 3, Inspecting Objects for Correct Measurements, introduces image calibration, and
the Detect Objects and Geometry steps. Follow the instructions in this chapter to create
an inspection that measures the distance between holes in a gasket to verify that the gasket
conforms to manufacturing specifications.

Chapter 4, Inspecting for Multiple Correct Instances of an Object, introduces the Find
Straight Edge, Caliper, and Decision Making steps. Follow the instructions in this
chapter to create an inspection that measures the distance between the blade connectors of
a fuse and checks the integrity of the fuse conductor regardless of the fuse position or
whether the fuse is inverted.

Chapter 5, Inspecting an Object that Spans Two Image Frames, introduces the Select
Image and Calculator steps. Follow the instructions in this chapter to create an inspection
that measures the width of a wooden plank that spans two images.

Chapter 6, Branching and Decision Making, introduces the inspection state diagram and
the Custom Overlay step. Follow the instructions in this chapter to create an inspection
that checks the image for the presence of a spray bottle and, if a bottle is present, transitions
to another state to determine if the bottle has a cap. If there is no spray bottle present in the
image, the inspection moves on to the next image.

Chapter 7, Looping and Variables, uses the inspection state diagram to implement a
looping inspection and introduces the Set Variable and Array Operator steps. Follow the
instructions in this chapter to create an inspection that inspects images of electronic
components to determine if the distance between pins on the component is within a
predetermined range. If the pin is too close or too far away from an adjacent pin, then the
inspection fails. The inspection does not need to check every pin on the microchip before
failing the inspection. The inspection fails at the first failed pin.

© National Instruments | ix



About This Manual

Related Documentation

The following documents contain information that you might find helpful as you read this
manual:

* NI Vision Builder for Automated Inspection Readme—Contains information about the

minimum system requirements, installation instructions, device support, and known issues

for NI Vision Builder for Automated Inspection. The NI Vision Builder for Automated
Inspection Readme is available at Start»All Programs»National Instruments»
Vision Builder AI Documentation.

* NI Vision Builder for Automated Inspection: Configuration Help—Contains information
about using the Vision Builder Al Configuration interface to create a machine vision

application. NI Vision Builder for Automated Inspection: Configuration Help is available

by selecting Help»Online Help from the Vision Builder AI Configuration interface.

* NI Vision Builder for Automated Inspection. Inspection Help—Contains information about
running applications created using Vision Builder Al in the Vision Builder Al Inspection

Interface. NI Vision Builder for Automated Inspection. Inspection Help is available by
selecting Help»Online Help from the Vision Builder Al Inspection interface.

* NI Developer Zone—Visit ni.com/zone for the latest example programs, tutorials,

technical presentations, and a community area where you can share ideas, questions, and

source code with developers around the world.

o ISC-178x User Manual—Describes the electrical and mechanical aspects of the ISC-178x
smart camera, troubleshooting guidelines, and information about the LEDs, and connectors

on the ISC-178x.

*  NIIC-317x User Manual—Describes the electrical and mechanical aspects of the NI 317x
industrial controller devices, software configuration guidelines, and information about the

LEDs and connectors on the those devices.
* NI Smart Camera 1/O Accessory User Guide—Describes the features of the NI Smart

Camera I/O Accessory, what you need to get started, and the installation and operation of

the device.

* NI Vision Concepts Help—Describes the basic concepts of image analysis, image
processing, and machine vision. This document also contains in-depth discussions
about imaging algorithms for advanced users. The NI Vision Concepts Help is available
by selecting Start»All Programs»National Instruments»Vision Builder Al
Documentation»NI Vision Concepts Help from the Start menu.

X | ni.com



Introduction to
Vision Builder Al

This chapter introduces the Vision Builder Al environment and describes how to run an
inspection.

Figures 1-1 and 1-2 show general instructions for creating a Vision Builder Al inspection.
Figure 1-1 describes the basic steps for designing a Vision Builder Al inspection. The Add
Inspection Steps module of Figure 1-1 is expanded in Figure 1-2.

© National Instruments |
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Chapter 1

Introduction to Vision Builder Al

Figure 1-1. Instructions for Creating a Basic Vision Builder Al Inspection
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I } Refer to Figure 1-2 for details.
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Figure 1-2. Adding Inspection Steps to a Vision Builder Al Inspection
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Chapter 1

Introduction to Vision Builder Al

Vision Builder Al Configuration Interface

Vision Builder Al has two modes of operation: Configuration and Inspection. Use the
1.

Configuration interface to configure and test your inspection. Use the Inspection interface to
deploy the software and perform online or offline visual inspection.

—

p)

Complete the following instructions to open the Vision Builder AI Configuration interface.
Select Start»All Programs»National Instruments»Vision Builder Al to launch Vision
Builder AL

Note By default, My Computer is selected in the list of targets. When My
2.

Computer is selected Vision Builder Al runs on the development computer.

On the Vision Builder AI welcome screen, click New Inspection or double click on My
Computer to open the Vision Builder Al Configuration Interface.

Elements of the Configuration Interface
Configuration window.

Figure 1-3 shows the Vision Builder Al Configuration interface. The Configuration interface
contains four areas: Main window, Overview window, Inspection Steps palette, and State
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Figure 1-3. Vision Builder Al Configuration Interface

7 7
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State:  Inspect Read Image File: Reads an image from a
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N Inspection inspect.
L T = I
Acquire Fuse Locate Fuse LeftEdge  Set Coordinate System  Measure Separation  Match Conductor 1 PASS
1 Main Window 3 Inspection Steps Palette
2 Overview Window 4  State Configuration Window

*  Main window—Displays the image being processed, property pages for some inspection
steps, or the state diagram for the inspection. Use the Main window to define regions of
interest in an image, configure step parameters for some steps, and create/modify the state
diagram for an inspection.

*  Overview window—Displays a thumbnail view of either the current inspection image or
the state diagram for the inspection.

« Inspection Steps palette—Lists and describes the steps that you use to create your
inspection. When you click on most steps, the palette transforms into the property page for
the step.

«  State Configuration window—Displays the list of steps in the currently selected state in
the inspection.

Inspection State Diagram

Vision Builder Al uses a state diagram to define inspections with unique states and transitions
that govern the execution flow of the inspection. Simple inspections can be defined using the
single-state default inspection, shown in Figure 1-4.

© National Instruments | 1-5



Chapter 1 Introduction to Vision Builder Al

Figure 1-4. Default Inspection State Diagram

Start

default

default

@

End

More complex inspections can be created by adding additional states and transitions to the
default state diagram. Figure 1-5 shows an example of an inspection that uses the state diagram
to perform branching and looping in the inspection.

Figure 1-5. Example of a Vision Builder Al Inspection State Diagram

Start

default

age & Find)Pin Edges

default

Acquire |

Within a state diagram, each state can lead to one or multiple states or can end the inspection
cycle. Each state diagram relies on in-state calculations or user input to determine the next state
to execute. Vision Builder Al executes the state diagram continuously from the Start point to the
End point.

Each state in an inspection is intended to contain a discrete set of inspection steps. To access the
steps contained in a state, select the state on the state diagram. The steps present in the state will
appear in the State Configuration window. The currently selected state is highlighted on the state
diagram. Chapter 6, Branching and Decision Making, and Chapter 7, Looping and Variables,
provide examples of using the state diagram.
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Vision Builder Al Inspection Interface

As mentioned in the Vision Builder AI Configuration Interface section of this chapter, use the
Vision Builder Al built-in Inspection Interface to deploy and run an inspection. Figure 1-6
shows the built-in Inspection interface, which has three main areas: the Results panel, the
Inspection Statistics panel, and the Display window.

Figure 1-6. Vision Builder Al Built-in Inspection Interface
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1 Inspection Statistics Panel 2 Display Window 3 Results Panel

*  Results panel—Lists the steps in the inspection by name. For each inspection step, Vision
Builder displays the step type, result (PASS or FAIL), measurement made, and a comment
explaining the reason of a FAIL. Inspection Status shows the result of the complete
inspection.

*  Display window—Displays the part under inspection.

«  Inspection Statistics panel—Contains three indicators that display the yield (ratio
between PASS and FAIL), active versus idle time, and processing time of the inspection.

Running an Inspection

Vision Builder Al allows you to run inspections from both the Configuration and Inspection
interfaces. The following sections describe the options for running an inspection in
Vision Builder Al

© National Instruments | 1-7



Chapter 1 Introduction to Vision Builder Al

Configuration Interface

Run an inspection from the Configuration interface during development to test and debug
inspections. The Highlight Execution, Pause, and Single Step options are useful for debugging
inspections. Table 1-1 lists the run options available for the Configuration interface:

Table 1-1. Configuration Interface Run Modes

Button Name Description
Run Inspection Once Runs the inspection through one iteration
1 of the state diagram.
Run Inspection in Loop Runs the inspection continuously.
»

Run Inspection Until Failure | Runs the inspection until the Inspection

X Status variable has a value of FAIL.
Run Inspection Fast Runs the inspection with similar timing
(13 and speeds as in the inspection interface.
— Run Inspection Multiple Runs the inspection a specified number of
Times times. This option is available only from

the Operate menu.

Stop Inspection Stops the inspection.

Highlight Execution Highlights the inspection execution when
you run the inspection. If the Highlight
Execution button appears yellow,
execution highlighting is enabled.

Pause Pauses or resumes execution of the
I I inspection. If the Pause button appears
red, execution is paused.

Step Into Steps through the inspection. Step Into is
'!l_‘l only available when the Pause button is
pressed.

1-8 | ni.com
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Table 1-1. Configuration Interface Run Modes (Continued)

Button Name Description

Step Over Runs the current state. Step Over is only

- available when the Pause button is
pressed.

Use Previous Image Uses the previous inspection image the
g next time the inspection executes.”

Use Current Image Uses the current inspection image the next
time the inspection executes.”

Use Next Image Uses the next inspection image the next
>"ih time the inspection executes.”

Select Next Image Specifies the inspection image to process
e the next time the inspection executes.”

simulated target.

* This button applies only to inspections that either contain a Read Image File step, or are open on a

Inspection Interface

After an inspection is configured, use the Inspection interface to run the inspection and/or deploy
your system. Complete the following instructions to run an inspection from the Inspection

interface:

@ Tip

If the Vision Builder Al Configuration interface is already open, select File»

Switch to Inspection Interface to open the current inspection in the Inspection
interface.

1. Select Start»All Programs»National Instruments»Vision Builder Al to launch the
Vision Builder Al

2. On the Vision Builder Al welcome screen, click Browse under Run Inspection.

Select the inspection that you want to run and click OK to open the inspection in the
Inspection Interface.

© National Instruments | 1-9



Chapter 1 Introduction to Vision Builder Al

4.

1-10

Click the Start Inspection button. Vision Builder Al begins running the inspection and
updating the three areas of the Inspection interface with the most recent inspection data.

>

By default, Vision Builder Al displays all the inspection images in the Display window.
You can change the display settings in the View pulldown below the Display window to
view only images that fail or to have no display. You also can change the magnification of
the displayed images using the zoom buttons below the Display window.

Notice the performance data displayed in the Inspection Statistics panel. This data can
help you determine how efficiently your inspection is running. Based on this data, you can
make adjustments to improve the inspection speed.

Click the Stop Inspection button to stop the inspection.
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Checking for the Presence
of a Part

This chapter introduces the Match Pattern, Measure Intensity, and Set Coordinate System
steps. Follow the instructions in this chapter to create an inspection that checks for the presence
of a spray bottle cap regardless of the bottle position in the inspection images.

Note Launch Vision Builder Al if it is not open. Refer to the Vision Builder Al

Configuration Interface section of Chapter 1, Introduction to Vision Builder Al,
for more information.

Creating a New Inspection

Select File»New to load a new, blank Vision Builder Al inspection.

Acquiring Inspection Images

In the Inspection Steps palette, the Acquire Images tab contains several acquisition steps you can
use to acquire images from many different types of cameras. The tab also contains a Read Image
File step, which simulates image acquisition by loading images from file. The Select Image step
enables you to switch to a previously acquired image that you need to process later in the
inspection.

For simplicity, this tutorial instructs you to use the Read Image File step. However, in your
real-world inspection, use one of the other image acquisition steps to acquire images of the
object under inspection.

Complete the following instructions to configure a Read Image File step that simulates
acquiring images of spray bottles.

1. In the Inspection Steps palette, select the Acquire Images tab.

2. Click the Read Image File step. The property page for the step opens.

b
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In the Step Name control, enter Acquire Spray Bottle.
4.  Click the Browse button. The Select an Image or AVI File dialog box opens.

5. Navigateto <Public Documents>\National Instruments\<Vision Builder
AI>\DemoImg\Tutorial 1.

Note Ensure that you have selected the appropriate folder if you have more than
one version of Vision Builder Al installed.

Select the first image, Image 01.jpg, and click Open.

Make sure the Cycle Through Folder Images control is enabled so that Vision Builder Al
loads a different simulation image from the folder each time the step is run.

8. Click OK to add the step to the inspection.

Defining a Feature on which to Base a
Coordinate System

In a machine vision inspection, you typically limit your inspection and processing to a region of
interest (ROI) rather than the entire image for the following reasons:

«  To improve your inspection results by avoiding extraneous objects

*  To increase inspection speed

To limit the inspection area, the parts of the object you are interested in must always be inside
the ROI you define.

If the object under inspection is fixtured and always appears at the same location and orientation
in the images you need to process, defining an ROI is straightforward. However, if the object
under inspection appears shifted or rotated within the images, the regions of interest need to shift
and rotate with the object under inspection.

For the regions of interest to move in relation to the object, you need to set a coordinate system
relative to a significant and original feature of the object under inspection. Choose a feature that
is always in the field of view of the camera despite the different locations that the objects may
appear in from image to image. Also, make sure the feature is not affected by major defects that
could drastically modify the visual appearance of the feature.

Complete the following instructions to configure a Match Pattern step that locates a bottle
feature on which you can base a coordinate system.
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In the Inspection Steps palette, select the Locate Features tab.

2. Click the Match Pattern step. The NI Vision Template Editor opens.

3. Draw arectangle around the base of the sprayer, as shown in Figure 2-1. This region
becomes the pattern matching template.

Figure 2-1. Creating a Template Pattern

@ NI Vision Template Editor - Select Template Region X
gl=]
qﬁi—f’—.ﬁ <
L @
=Y
Q
&
— v
640x480 1.06X 8-bitimage 255 (517,104) < >
<< Previous Next >> Finish Cancel Help

4. Click Next.
5. Click Finish to accept the template.
6. On the Main tab, enter Locate Sprayer Base in the Step Name control.

The green ROI specifies the area of the image in which Vision Builder Al tries to locate the
template. Assuming that the bottles are fixtured in such a way that they can move only
horizontally within the field of view, you can limit the ROI so that it surrounds only the area of
the image that may contain a template match during inspection.
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7. Redraw or decrease the default green ROI so that it surrounds only the lower portion of the
image, as shown in Figure 2-2.

Figure 2-2. Limiting the Search Region

Qﬁiﬁ

Locate Sprayer Base

8. On the Specifications tab,
. set Number of Matches to Find to 1, and
¢ uncheck Rotated.

9. On the Limits tab, enable the Minimum Number of Matches control, and set the
value to 1.

10. Click OK to add the step to the inspection.

Setting a Coordinate System

Complete the following instructions to configure a Set Coordinate System step based on the
Match Pattern step you configured.

1. Inthe Inspection Steps palette, select the Locate Features tab.
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Click the Set Coordinate System step. The property page for the step opens.

-

On the Main tab, enter Coordinate System in the Step Name control.

Select Horizontal and Vertical Motion from the Mode control because the bottles appear
shifted but not rotated from one image to another.

*

Notice the Origin list. Match [1], the match location of the previous Locate Sprayer Base
step, is the default origin of the coordinate system because it is the only location point
created by previous steps in the inspection.

Click OK to add the step to the inspection.

Checking for the Cap Using Measure Intensity

The image of the spray bottle was acquired using a backlight. The cap appears dark on the bright
background. Complete the following instructions to configure a Measure Intensity step to
check for the presence of a spray bottle cap.

1.

In the Inspection Steps palette, select the Measure Features tab.

Click the Measure Intensity step. The property page for the step opens.

Q

On the Main tab, enter Check Cap Presence in the Step Name control.
Enable the Reposition Region of Interest control.

Enabling this control allows you to link the regions of interest specified in this step to a
previously defined coordinate system so that Vision Builder Al can adjust the location and
orientation of the ROI from image to image relative to the specified coordinate system.

The Reference Coordinate System list shows all the previously defined coordinate
systems. Coordinate System is the default reference coordinate system because it is the
only Set Coordinate System step in the current inspection.

Notice that the Measure Intensity step supports a variety of different tools that enable you
to draw different shaped regions of interest, such as a point, line, broken line, freehand line,
rectangle, ellipse, annulus, polygon, and freehand region. These tools are available in the
main toolbar.

© National Instruments | 2-5



Chapter 2 Checking for the Presence of a Part

5.

Using the default Rectangle Tool, draw a region that enclose the top of the cap then hold
down the <Ctrl> key, and draw two other regions of interest that enclose the edges on the
sides of the cap, as shown in Figure 2-3. Pressing the <Ctrl> key enables you to draw
multiple regions of interest for the step.

-

Figure 2-3. Defining Regions in Which to Measure Intensity

2-6

Check Cap Presence

=

Click the Limits tab.

At the bottom of the Limits tab, Vision Builder Al returns the intensity statistics of the
pixels inside the regions of interest. Pixel intensities can range from 0 through 255, where
0 equals black and 255 equals white.

The Minimum Intensity value at the bottom of the page returns the lowest pixel value
inside the regions of interest. The backlit edges of the plastic cap appear in silhouette as
dark pixels (which have low pixel intensities) on a bright background (which has high pixel
intensities).

Therefore, when the cap is present, the minimum intensity for the regions is low. When the
cap is not present, the minimum intensity for the regions is high because the regions contain
only bright background pixels.
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Enable the Minimum control. Set the Maximum value to 50. 00.
Click OK to add the step to the inspection.
Click the Run State Once button located in the State Configuration window.

1

Vision Builder Al loads the next image, Image 02.jpg, from the
C:\Users\Public\Public Documents\National Instruments\<Vision
Builder AI>\DemoImg\Tutorial 1 folder and runs the previous inspection steps in
the state on the new image.

Notice that the bottle appears closer to the left edge of the image. Vision Builder Al
repositions the regions of interest based on the new location of the bottle. The Step Status
for the image is PASS because the presence of the cap inside the regions of interest causes
the Minimum Intensity value to fall within the limits you set.

Setting the Inspection Status

Complete the following instructions to add a Set Inspection Status step to determine whether
the inspection passes or fails.

1.

2.

3.
4.

In the Inspection Steps palette, select the Use Additional Tools tab.

7

Click the Set Inspection Status step. The property page for the step opens.

8

In the Inspection Status control, select the Set to FAIL if any previous step fails option.

Click OK to add the step to the inspection.
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Testing the Inspection

Test the remaining images in the Tutorial 1 folder to make sure the inspection returns the
correct results. Click the Run Inspection Once button to test the remaining images. Table 2-1
displays the expected results for each image.

1

Table 2-1. Expected Results for the Spray Bottle Inspection

Image Name Inspection Status Explanation
Image 01.3pg PASS Cap is present.
Image 02.3pg PASS Cap is present.
Image 03.3pg PASS Cap is present.
Image 04.3pg PASS Cap is present.
Image 05.jpg FAIL Cap is missing.

Saving the Inspection

Complete the following instructions to save the example inspection.

1. Select File»Save or click the Save button on the toolbar.

H

2. Navigate to the location where you want to save the inspection.
3. Inthe File Name control, enter Tutorial 1.vbai.

4.  Click Save to save the inspection.

@ Tip Select FilenInspection Properties to add a short description or comments
about the inspection.
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Inspecting Objects for
Correct Measurements

This chapter introduces image calibration, and the Detect Objects and Geometry steps. Follow
the instructions in this chapter to create an inspection that measures the distance between holes
in a gasket to verify that the gasket conforms to manufacturing specifications.

Note Launch Vision Builder Al if it is not open. Refer to the Vision Builder Al

Configuration Interface section of Chapter 1, Introduction to Vision Builder Al,
for more information.

Creating a New Inspection

Select File»New to load a new, blank Vision Builder Al inspection.

Acquiring and Calibrating Inspection Images

For simplicity, this tutorial instructs you to use the Read Image File step. However, in your
real-world inspection, use one of the other image acquisition steps to acquire images of the
object under inspection.

Complete the following instructions to configure a Read Image File step that simulates
acquiring images of gaskets.
1. Inthe Inspection Steps palette, select the Acquire Images tab.

2. Click the Read Image File step. The property page for the step opens.

b

3. Inthe Step Name control, enter Acquire Gasket.
4.  Click the Browse button. The Select an Image or AVI File dialog box opens.
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5. Navigateto <Public Documents>\National Instruments\<Vision Builder
AI>\DemoImg\Tutorial 2.

Note Ensure that you have selected the appropriate folder if you have more than
one version of Vision Builder Al installed.

6. Select the first image, Image 01.7pg, and click Open.

7. Make sure that the Cycle Through Folder Images control is enabled so that Vision Builder
Al loads a different simulation image from the folder each time the step is run.

By default, Vision Builder Al returns measurements in pixel units. If you want the inspection to
return measurements in real-world units, you need to map pixel units to real-world units through
a process called spatial calibration.

8. Click the Calibration tab.

9.  Click Create Calibration to launch the calibration training interface.
10. In the Calibration Name control, enter Gasket Calibration.
11. Click Next.

For this example, assume that the camera that acquired the inspection images is perpendicular
to the image plane and lens distortion is negligible. Based on these assumptions, you can use
Point Distance Calibration to calibrate your images. Point Distance Calibration transforms a
pixel coordinate to a real-world coordinate through scaling in the x (horizontal) and y (vertical)
directions.

12. Select the Point Distance Calibration option, and click Next.

13. Make sure that the current image is selected, and click Next.
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14. Carefully click the 0 mm and 50 mm markings on the ruler at the bottom of the image, as
shown in Figure 3-1.

@ Tip You may need to use the zoom buttons below the image to accurately click the
- ruler markings. You can also zoom in by using the mouse wheel. After zooming in,
scroll down to see the ruler at the bottom of the image.

Figure 3-1. Specifying the Pixel Ratio

Step 4 - Specify Real-World Distances

Spedify a different scale for the Y axis if your sensor
has rectangular pixels, or if you want to account for
scaling in only one direction. Click Next to define
walues for the Y axis,

Specify a different scale for the ¥ axis

Select 2 paints by dicking the image, then define the
distance between the points in real-world units. Select
the point in the list to adjust X and ¥ coordinates.

Paints
Points. X ¥

1-User Point 1 180 a4z |2

2-User Point 2 450 4“1

Distances
Image Real World

Length 270.00 50 &

Unit pixels milimeter |+

v <<Previous | | Next>>
640x480 1X  (0,0) <

] e Qg

oK Cancel Help

15. In the Distances control, enter 50 for the Real World value, and select millimeter for
the Unit.

16. Click Next.
17. Ignore the Compute Lens Distortion Model option and click Next.
In the Specify Calibration Axis step, you can define the origin and angle of the calibration axis

anywhere in the image. By default, the top, left pixel in the image is the calibration axis origin,

and the horizontal axis of the image is the calibration axis angle. Use the default calibration axis
settings for this exercise.

@ Tip In some applications, you may want to measure between a fixed reference
feature on the part and other features in the image. Setting the origin of the calibration
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axis to the location of the reference feature simplifies making measurements because
the starting point for the measurements becomes 0.

18. Click Next.
19. Click OK to learn the calibration information and exit the calibration training interface.
20. Click OK to add the step to the inspection.

Vision Builder Al typically saves the calibration to <ProgramData>\National
Instruments\Vision Builder AI\Calibration.

@ Tip You can apply the learned calibration to all images acquired with the same
= .
camera at the same resolution.

Locating Features to Measure

Complete the following instructions to configure a Detect Objects step that finds small holes in
the gasket.

1. Inthe Inspection Steps palette, select the Check for Presence tab.

2. Click the Detect Objects step. The property page for the step opens.

-

3. Inthe Step Name control, enter Detect Small Holes.
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4. Using the default Rectangle Tool, draw a region of interest (ROI) around the entire gasket,
as shown in Figure 3-2.

|

Figure 3-2. Defining the ROI

'S s - -~ A e
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5. Inthe Threshold tab, select the Bright Objects option for the Look For control.

Notice that the blue shading highlights all bright pixels—pixels with high intensity values
that fall within the Threshold Range—in the ROI. Vision Builder Al groups contiguous
highlighted pixels into objects, which are depicted by red bounding rectangles.
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6. Click the Settings tab. Scroll the Objects table to the right to view the Area (mm)
measurement.

The step locates four objects, which are listed in Table 3-1. Depending on the location of
the user-defined points previously configured in the calibration, the values for the
Size (mm?) may differ slightly from the values shown in Table 3-1.

Table 3-1. Sizes of Gasket Holes

Object Number Size (mm2)
1 62.43
2 461.26
3 1410.15
4 61.50

Object 1 and Object 4 are the small holes of interest in this step. The following steps describe
how to use the Minimum Object Size and Maximum Object Size controls of the Detect
Objects step to eliminate objects of no interest based on their size.

7.  Enable the Minimum Object Size and Maximum Object Size controls.

Based on the information in Table 3-1, the small holes have sizes of 61.97 mm? and
61.04 mm?.

Set Minimum Object Size to 50 and Maximum Object Size to 70.

9. In the Limits tab, enable the Minimum Number of Objects and Maximum Number of
Objects controls. Set their values to 2.

10. Click OK to add the step to the inspection.

Complete the following instructions to find the large hole in the gasket.

1. Right-click the Detect Small Holes step in the State Configuration window, and
select Copy.

2. Right-click the Detect Small Holes step again.
Select Paste. A copy of the Detect Small Holes step is placed after the original step.

4. Double-click the Detect Small Holes copy or click the Edit Step button to launch the
property page of the step for editing.

rd

+

5. Inthe Step Name control, enter Detect Large Hole.
6. Select the Settings tab.

Based on the information in Table 3-1, the large hole has a size of 1410.15 mm?.
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Set Minimum Object Size to 1300 and Maximum Object Size to 1450.

In the Limits tab, enable the Minimum Number of Objects and Maximum Number of
Objects controls. Set their values to 1.

Click OK to add the step to the inspection.

Measuring Parts of the Gasket

Complete the following instructions to measure the distance from the top small hole to the large
hole to inspect whether the distance meets specifications.

Note Vision Builder Al returns the centers of mass for the holes as their locations.

1.

AN

10.
I1.

12.
13.
14.

15.

In the Inspection Steps palette, select the Measure Features tab.

Click the Geometry step. The property page for the step opens.

"

",
-

In the Step Name control, enter Check Distance.
Click Add Feature icon.
In the Feature Name control, enter Check Top Distance.

In the Geometric Feature control, select the Distance.

i

Click the Browse button and select Step #2: Detect Small Holes >> 1:Object [1]. Center
of Mass (Pixels).

Click OK.
Click the Browse button and select Step #3: Object [1].Center of Mass (Pixels).
Click OK.

Select the Distance check box in the Condition control and set Minimum and Maximum
as 32 and 35 respectively.

Click Add Feature icon.
In the Feature Name control, enter Check Bottom Distance.

Click the Browse button and select Step #2: Detect Small Holes >> 2: Object [2].Center
of Mass (Pixels).

Click OK.
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16. Click the Browse button and select Step #3: Object[1].Center of Mass (Pixels).
17. Click OK.

18. Select the Distance check box in the Condition control and set Minimum and Maximum
as 38 and 40 respectively.

19. Click OK to add the step to the inspection.

Setting the Inspection Status

Complete the following instructions to add a Set Inspection Status step to determine whether
the inspection passes or fails.

1. Inthe Inspection Steps palette, select the Use Additional Tools tab.

7

2. Click the Set Inspection Status step. The property page for the step opens.

8

3. In the Inspection Status control, select the Set to FAIL if any previous step fails option.
4. Click OK to add the step to the inspection.
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Test the inspection to make sure it returns the results you expect. Click the Run Inspection
Once button to run the inspection on each of the test images. Table 3-2 lists the test images, the
inspection status to expect for each image, and an explanation of the status.

1

Table 3-2. Expected Results for the Gasket Inspection

Inspection
Image Name Status Explanation

Image 01.3pg PASS All steps passed.

Image 02.3pg PASS All steps passed.

Image 03.3pg PASS All steps passed.

Image 04.3pg FAIL The Check Distance step failed because the

distance between the holes is too small.
Image 05.jpg FAIL The Detect Small Holes step failed because the

bottom hole is missing. The missing hole also
caused the Check Distance step to fail.

Saving the Inspection

Complete the following instructions to save the example inspection.

1.  Select File»Save or click the Save button on the toolbar.

H

2. Navigate to the location where you want to save the inspection.

3. Inthe File Name control, enter Tutorial 2.vbai.

4.  Click Save to save the inspection.

9

Tip Select FilenInspection Properties to add a short description or comments
about the inspection.
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Inspecting for Multiple
Correct Instances of an
Obiject

This chapter introduces the Find Straight Edge, Caliper, and Decision Making steps. Follow
the instructions in this chapter to create an inspection that measures the distance between the
blade connectors of a fuse and checks the integrity of the fuse conductor regardless of the fuse
position or whether the fuse is inverted.

Note Launch Vision Builder Al if it is not open. Refer to the Vision Builder Al

Configuration Interface section of Chapter 1, Introduction to Vision Builder Al,
for more information.

Creating a New Inspection

Select File»New to load a new, blank Vision Builder Al inspection.

Acquiring Inspection Images

For simplicity, this tutorial instructs you to use the Read Image File step. However, in your
real-world inspection, use one of the other image acquisition steps to acquire images of the
object under inspection.

Complete the following instructions to configure a Read Image File step that simulates
acquiring images of fuses.

1. Inthe Inspection Steps palette, select the Acquire Images tab.

2. Click the Read Image File step. The property page for the step opens.

b

3. Inthe Step Name control, enter Acquire Fuse.
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4.  Click the Browse button. The Select an Image File dialog box opens.

5. Navigate to <Public Documents>National Instruments\<Vision Builder
AI>\DemoImg\Tutorial 3.

Note Ensure that you have selected the appropriate folder if you have more than
one version of Vision Builder Al installed.

Select the first image, Image 01.jpg, and click Open.

Make sure the Cycle Through Folder Images control is enabled so that Vision Builder Al
loads a different simulation image from the folder each time the step is run.

8. Click OK to add the step to the inspection.

Defining a Feature on which to Base a
Coordinate System

The fuses can appear shifted horizontally and slightly rotated from one inspection image to
another. Complete the following instructions to configure a Find Straight Edge step that finds
the left edge of the fuse so that regions of interest in subsequent steps can shift with the fuse.

1. In the Inspection Steps palette, select the Locate Features tab.

2. Click the Find Straight Edge step. The property page for the step opens.

3. Inthe Step Name control, enter Locate Fuse Left Edge.
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Draw a region of interest (ROI) across the left edge of the fuse, as shown in Figure 4-1.

Figure 4-1. Finding a Straight Edge

Notice that the ROI contains blue search lines. The step searches along the search lines for
sharp transitions in pixel intensities, which usually represent object edges. The step fits a
straight line through the individual detected edge points of each search line to determine the
left edge of the fuse.

Click OK to add the step to the inspection.
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Setting a Coordinate System

Complete the following instructions to configure a Set Coordinate System step based on the
Find Straight Edge step you configured.

1. Inthe Inspection Steps palette, select the Locate Features tab.

2. Click the Set Coordinate System step. The property page for the step opens.

b

In the Main tab, enter Set Coordinate System inthe Step Name control.

4. Select Horizontal Motion from the Mode control.
4—4_’

Notice the Origin list. Point 1, the first point of the straight line detected by the Locate
Fuse Left Edge step, is the default origin of the coordinate system. In this exercise, the
location of the origin does not affect the measurement you need to make. Therefore, use the
default origin.

5. Click OK to add the step to the inspection.

Measuring the Separation between Connectors

Complete the following instructions to configure a Caliper step that measures the distance
between the blade connectors of the fuse.

1. In the Inspection Steps palette, select the Measure Features tab.

2. Click the Caliper step. The property page for the step opens.

|l

In the Main tab, enter Measure Separation inthe Step Name control.

4. Enable the Reposition Region of Interest control.
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5. Draw an ROI across the blade connectors, as shown in Figure 4-2.

Figure 4-2. Measuring the Distance Between Two Edges

6. Inthe Settings tab, select the Process named Vertical Min Caliper to change the direction
and orientation of the caliper search lines.

=5
%

7.  Inthe Limits tab, enable the Minimum Distance control and set the value to 150. Enable
the Maximum Distance control and set the value to 160.

8. Click OK to add the step to the inspection.
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Inspecting the Fuse Conductor

Complete the following instructions to configure Match Pattern steps that inspect the integrity
of the fuse conductor.
1. Inthe Inspection Steps palette, select the Locate Features tab.

2. Click the Match Pattern step. The NI Vision Template Editor opens.

3. Draw an ROI around the conductor, as shown in Figure 4-3. This region becomes the
pattern matching template.

Figure 4-3. Creating a Template Pattern
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Cancel Help
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4. Click Next.
Click Finish to accept the template.
6.  On the Main tab, enter Match Conductor 1 inthe Step Name control.
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Make sure the Reposition Region of Interest control is enabled.

Redraw or decrease the default green ROI so that it surrounds an area slightly larger than
the template, as shown in Figure 4-4.

Figure 4-4. Limiting the Search Region

9. In the Specifications tab, set Number of Matches to Find to 1.
10. Inthe Limits tab, enable the Minimum Number of Matches control and set the value to 1.
11. Click OK to add the step to the inspection.

12. Click the Run Inspection Once button twice so that Image 03.jpg becomes the active
image.

1

Note The name of the active image is displayed in the Acquire Fuse step in the
State Configuration window.
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A fuse may be inverted when Vision Builder Al acquires an image of the fuse. This inversion
causes the conductor to look different than the template, shown in Figure 4-5a. To prevent a good
but inverted fuse from failing inspection, you need to learn a pattern matching template for the
inverted instances of the conductor as well, shown in Figure 4-5b.

Figure 4-5. Valid Templates for the Conductor

13.

14.

15.
16.
17.
18.

19.

20.
21.
22.

4-8

a. b.

In the Inspection Steps palette, select the Locate Features tab.

Click the Match Pattern step. The NI Vision Template Editor opens.

Draw an ROI around the conductor, similar to the region you drew in step 3.
Click Next to learn the inverted template.

Click Finish in the NI Vision Template Editor window.

In the Step Name control, enter Match Conductor 2.

Set the Region of Interest control to Match Conductor 1. This configures the Match
Conductor 2 step to use the same ROI that you previously defined for the Match
Conductor 1 step.

In the Specifications tab, set Number of Matches to Find to 1.
In the Limits tab, enable the Minimum Number of Matches control and set the value to 1.
Click OK to add the step to the inspection.
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Making Logical PASS/FAIL Decisions

In the previous lessons, the inspection would fail if any of the steps in the inspection failed. In
this lesson, because the conductor under inspection can match only one of the patterns you
specified, one of the Match Pattern steps always fails. If you were to set the Inspection Status
to fail if any of the steps in the inspection fail, the entire inspection will always fail because one
of the Match Pattern steps always fails.

Using the Logic Calculator step, you can create a Boolean result that is based on the results of
the previous inspection steps. The Set Inspection Status step can use this Boolean result to
determine the Inspection Status.

Complete the following instructions to configure a Logic Calculator step that causes the
inspection to pass when the conductor matches either the template in Match Conductor 1 or
Match Conductor 2, and when the Measure Separation step passes.

1. Inthe Inspection Steps palette, select the Use Additional Tools tab.

7

2. Click the Logic Calculator step. The property page opens in the Main window.

D

In the Step Name control, enter Decide Pass/Fail.

4. In the First Operand frame, set Source to Measure Separation. Set Measure to Step
Status.

Current Value displays the value of the measurement based on the current image.
5. Make sure Second Operand is set to Constant, and Constant is set to True.
Click Add to add this expression to the Expression table.

In the First Operand frame, set Source to Match Conductor 1. Set Measure to Step
Status.

Make sure Second Operand is set to Constant, and Constant is set to True.
9. Click Add to add this expression to the Expression table.
Notice the default binary operator AND in the last column of the Expression table.

10. In the First Operand frame, set Source to Match Conductor 2. Set Measure to Step
Status.

11. Make sure Second Operand is set to Constant and Constant is set to True.
12. Click Add to add this expression to the Expression table.

13. Select the second expression in the Expression table, and click AND/OR to change the
binary operator to OR.
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14. Hold down the <Shift> key, and select the second and third expressions in the Expression
table.

15. Click () to group the expressions.

The Logic Calculator property page should resemble Figure 4-6.
Figure 4-6. Logic Calculator Property Page

Step Mame  |Decide Pass/ Fail
Operands
First Operand Second Operand
Operator
Source  |Match Conductor 2 ~ = w © Constant  |True w
Measure |Step Status ~ Source
? Add
Current Value: Pass =
Result Insert
Replace
Expression
{ | First Operand MNOT | Operator | Second Operand ) Result = ANDJOR ANDJOR
Measure Separation - Step Status = TRUE \Tre  AND
Match Conductor 1 - Step Status = TRUE \True | OR Negate
e Camtcr S e — . =
Logic Result Delete
Mode
@ Step passes inspection when Logic Result is TRUE. Step Status
Step passes inspection if the Expression can be evaluated {j.e. all necessary results oK
are avallable). The Logic Result is logged as a boolean measurement that can be
used in future steps. Cancel

16. Click OK to add the step to the inspection.

Setting the Inspection Status

Complete the following instructions to configure Vision Builder Al to pass the inspection when
the Logic Calculator step passes, regardless of the results of individual steps in the inspection.

1. Inthe Inspection Steps palette, select the Use Additional Tools tab.

7

2. Click the Set Inspection Status step. The property page for the step opens.

8

3. Inthe Step Name control enter Set Inspection Status.
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4. In the Inspection Status control select the Set to measurement value option, and select
Decide Pass/Fail - Step Status for the value.

5. Make sure the Update Number of Parts Inspected control is enabled.
6. Click OK to add the step to the inspection.

Testing the Inspection

Test the inspection to make sure it returns the results you expect. Click the Run Inspection
Once button to test the remaining images. Table 4-1 lists the test images, the inspection status
to expect for each image, and an explanation of the status.

1

Table 4-1. Expected Results for the Fuse Inspection

Image Name Inspection Status Explanation

Image 01.7jpg PASS All steps pass but one Match Pattern step.

Image 02.7pg PASS All steps pass but one Match Pattern step.

Image 03.7pg PASS All steps pass but one Match Pattern step.

Image 04.7pg PASS All steps pass but one Match Pattern step.

Image 05.7pg PASS All steps pass but one Match Pattern step.

Image 06.7pg FAIL The Measure Separation step fails because
the blade connectors are too close together.

Image 07.3pg FAIL Both Match Pattern steps fail because the
conductor is blown.

Image 08.jpg FAIL Both Match Pattern steps fail because the
conductor is melted.
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Saving the Inspection

Complete the following instructions to save the example inspection.

1.  Select File»Save or click the Save button on the toolbar.

H

2. Navigate to the location where you want to save the inspection.
3. Inthe File Name control, enter Tutorial 3.vbai.

4.  Click Save to save the inspection.

@ Tip Select FilexInspection Properties to add a short description or comments
about the inspection.
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Inspecting an Object that
Spans Two Image Frames

This chapter introduces the Select Image and Calculator steps.

Assume that you need to measure the width of a wide wooden plank with high accuracy. The
only cameras available for the application have low pixel resolutions.

To measure the width of a plank, you need to locate its left and right edges. If you were to set up
the imaging system so both edges of a plank fit within an available camera’s field of view, the

resulting image detail would be too low to yield accurate measurements. Because the required

image detail exceeds the pixel resolution capability of a single camera, two cameras per plank

are needed—one camera to acquire an image of the left edge and one camera to acquire an image
of the right edge.

Follow the instructions in this chapter to create an inspection that measures the width of a
wooden plank that spans two images.

Note Launch Vision Builder Al if it is not open. Refer to the Vision Builder Al

Configuration Interface section of Chapter 1, Introduction to Vision Builder Al,
for more information.

Creating a New Inspection

Select File»New to load a new, blank Vision Builder Al inspection.

Acquiring Inspection Images from Two Cameras

For simplicity, this tutorial instructs you to use the Read Image File step. However, in your
real-world inspection, use one of the other image acquisition steps to acquire images of the
object under inspection.
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Acquiring and Calibrating the Image of the Left Edge

Complete the following instructions to configure Read Image File steps that simulate acquiring
an image of the left section of the wooden plank and calibrating the image.

1. Inthe Inspection Steps palette, select the Acquire Images tab.

2. Click the Read Image File step. The property page for the step opens.

b

In the Step Name control, enter Acquire Plank (Left).
4.  Click the Browse button. The Select an Image File dialog box opens.

5. Navigateto <Public Documents>\National Instruments\<Vision Builder
AI>\DemoImg\Tutorial 4 Left.

Select the first image, Image 01.jpg, and click Open.

Make sure that the Cycle Through Folder Images control is enabled so that Vision Builder
Al loads a different simulation image from the folder each time the step is run.

8. Click the Calibration tab.

9.  Click Create Calibration to launch the calibration training interface.

10. In the Calibration Name control, enter Plank Calibration (Left).
11. Click Next.

For this example, assume that the camera that acquired the inspection images is perpendicular
to the image plane and lens distortion is negligible. Based on these assumptions, you can use
Point Distance Calibration to calibrate your images. Point Distance Calibration transforms a
pixel coordinate to a real-world coordinate through scaling in the x (horizontal) and y (vertical)
directions.

12. Select the Point Distance Calibration option, and click Next.

13. Make sure that the current image is selected, and click Next.
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14. Carefully click the 1 cm and 5 cm markings on the ruler at the bottom of the image, as
shown in Figure 5-1.

Tip You may need to use the zoom buttons below the image or the mouse wheel to
accurately click the ruler markings. After zooming in, scroll down to see the ruler at
the bottom of the image.

Figure 5-1. Defining the Pixel to Real-World Ratio

@ NI Calibration Training Interface - Mew Calibration [m} x

Step 4 - Specify Real-World Distances

Spedify a different scale for the Y axis if your sensor
hias rectangular pixels, or if you want to account for
scaling in only one direction. Click Next to define
values for the ¥ axis.

|| Spedfy a different scale for the Y axis

Select 2 points by dicking the image, then define the
distance between the points in real-world units. Select
the pointin the list to adjust ¥ and ¥ coordinates.

Distances
Image Real World

v
540x480 1X (0,0 < >
B qQQ ‘ oK ||CEnoe\ H Help |

15. In the Distances control, enter 4 for the Real World value, and select centimeter for
the Unit.

16. Click Next.
17. Ignore the Compute Lens Distortion Model option and click Next.
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18. In the Specify Calibration Axis step, click the 1 cm marking to define it as the origin of
the calibration axis. Draw a line horizontally and to the right along the edge of the ruler to
define the angle of the calibration axis, as shown in Figure 5-2.

Figure 5-2. Defining the Origin and Angle of the Calibration Axis

a
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. 27 <3 &G

v << Previous Next >>
633478 X (0,0) < >

® 8 qQ oK Cancel Help

19. Set the Axis Reference control to Direct.

20. Click Next.

21. Click OK to learn the calibration information and exit the calibration training interface.
22. Click OK to add the step to the inspection.

Acquiring and Calibrating the Image of the Right Edge

This section simulates acquiring an image of the right section of the wooden plank. Because the
simulated acquisition represents a second camera, you cannot reuse the calibration that you
created for the first camera.

Complete the following instructions to configure Read Image File steps that simulate acquiring
an image of the right section of the wooden plank and calibrating the image.

1. In the Inspection Steps palette, select the Acquire Images tab.
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Click the Read Image File step. The property page for the step opens.

In the Step Name control, enter Acquire Plank (Right).
Click the Browse button. The Select an Image File dialog box opens.

Navigate to <Public Documents>\National Instruments\<Vision Builder
AI>\DemoImg\Tutorial 4 Right.

Note Ensure that you have selected the appropriate folder if you have more than

9.

10.

11.

one version of Vision Builder Al installed.

Select the first image, Image 01.jpg, and click Open.

Make sure the Cycle Through Folder Images control is enabled so that Vision Builder Al
loads a different simulation image from the folder each time the step is run.

Click the Calibration tab.

Click Create Calibration to launch the calibration training interface.

In the Calibration Name control, enter Plank Calibration (Right).
Click Next.

Again, assume that the camera that acquired the inspection images is perpendicular to the image
plane and lens distortion is negligible.

12.
13.

Select the Point Distance Calibration option, and click Next.

Make sure the current image is selected, and click Next.

© National Instruments | 5-5



Chapter 5

14. Carefully click the 38 cm and 42 cm markings on the ruler at the bottom of the image, as
shown in Figure 5-35-3.

Tip You may need to use the zoom buttons below the image or the mouse wheel to
accurately click the ruler markings. After zooming in, scroll down to see the ruler at

the bottom of the image.

Inspecting an Object that Spans Two Image Frames

Figure 5-3. Defining the Pixel to Real-World Ratio

& NI Calibration Training Interface - New Calibration
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scaling in only one direction. Click Next to define
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15. In the Distances control, enter 4 for the Real World value and select centimeter for
the Unit.
16. Click Next.
17. Ignore the Compute Lens Distortion Model option and click Next.

56 |
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18. In the Specify Calibration Axis step, click the 38 cm marking to define it as the origin of
the calibration axis. Draw a line horizontally and to the right along the edge of the ruler to
define the angle of the calibration axis, as shown in Figure 5-4.

Figure 5-4. Defining the Origin and Angle of the Calibration Axis
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19. Set the Axis Reference control to Direct.

20. Click Next, then OK to learn the calibration information and exit the calibration training
interface.

21. Click OK to add the step to the inspection.

Locating the Right Edge of the Part

Complete the following instructions to configure a Find Edges step that locates the right edge
of the part.

1. In the Inspection Steps palette, select the Locate Features tab.

|
Ed

2. Click the Find Edges step. The property page for the step opens.
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2y

3. Inthe Step Name control, enter Find Right Edge.
4. Draw a line across the right edge of the part going from right to left, as shown in Figure 5-5.

@ Tip Pressing the <Shift> key while drawing a line constrains the line tool to only
draw horizontal or vertical lines.

5. Click the Settings tab.
6. Inthe Look for control, select First Edge.
7. In the Edge Polarity control, select Bright to Dark Only.
Figure 5-5. Finding the Right Edge of the Plank

Find Right Edge

Illllll IIII|IIIE Illlilﬂl IIIIII]II IIII|I|I| ||I||HII IIII|HH IIII|IIII

38 39 40 41 42 43 44 4

Notice the red square on the search line. The step searches along the search line for a sharp
transition in pixel intensities, which usually represents an object edge. The red square
marks the location of the right edge of the part.

8. Click OK to add the step to the inspection.
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Switching Images

Now that you have configured the inspection to locate the right edge of the wooden plank, you
need to switch to the image of the left side of the plank. Complete the following instructions to
configure a Select Image step that makes the image of the left side of the plank active for
processing.

1. In the Inspection Steps palette, select the Acquire Images tab.

2. Click the Select Image step. The property page for the step opens.
vy
4

In the Step Name control, enter Switch to Left Side.

4. Inthe Image Selection list, select Acquire Plank (Left). The image of the left side of the
part appears in the Main window.

5. Click OK to add the step to the inspection.

Locating the Left Edge of the Part

Complete the following instructions to configure a Find Edges step that locates the left edge of
the part.

1. In the Inspection Steps palette, select the Locate Features tab.

2. Click the Find Edges step. The property page for the step opens.
3. Inthe Step Name control, enter Find Left Edge.

© National Instruments | 5-9



Chapter 5 Inspecting an Object that Spans Two Image Frames

4. Hold down the <Shift> key and draw a line across the left edge of the part going from left
to right, as shown in Figure 5-6.

Click the Settings tab.
6. In the Look for control, select First Edge.
In the Edge Polarity control, select Bright to Dark Only.
Figure 5-6. Finding the Left Edge of the Plank

Find Left Edge

p Al

The step searches along the search line and marks the location of the left edge with a red
square.

8. Click OK to add the step to the inspection.
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Calculating the Width of the Part

Now that you have located the right edge of the part in one image and the left edge of the part in
another image, you need to combine the measurements from the two images to determine the
width of the part. Use the Calculator step to combine the two measurements and compute the
width.

Refer to the following equations as you configure the step.
Right (LC) = Right (RC) + (Origin R - Origin L) 5-1)
Part Width = Right (LC) - Left (LC) (5-2)
where  Right (LC) = The x position of the right edge in the calibration axis of the left edge.

Right (RC) = The x position of the right edge in the calibration axis of the right edge.
This corresponds to the calibrated x position result of the Find Right Edge step.

Origin R = The x position of the origin in the calibration axis of the right edge.
Origin L = The x position of the origin in the calibration axis of the left edge.

Left (LC) = The x position of the left edge in the calibration axis of the left edge. This
corresponds to the calibrated x position result of the Find Left Edge step.

Setting Calculator Step Inputs and Outputs

Complete the following instructions to configure a Calculator step to select the input
measurements from the previous Find Right Edge and Find Left Edge steps, and create output
results for the calculated values.

1. In the Inspection Steps palette, select the Use Additional Tools tab.

2. Click the Calculator step. The Calculator Setup Wizard opens.

B

Notice the Input Measurements list. The list contains all of the measurable data from each of
the previous steps in the inspection.
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3. Select the following measurements from the Input Measurements list:

*  Step#3:Find Right Edge»Edge [].X Position (Calibrated)»Edge [1].X Position (Cali
brated)

*  Step#5: Find Left Edge»Edge [].X Position (Calibrated)»Edge [1].X Position
(Calibrated)

4. Select Output Results tab.
5. Click Add New Output Result. A new output appears in the OQutput Results list.
6. Inthe Name control, enter Part Width. This output will contain the results of
Equation 5-2.
Make sure Type is set to Numeric.
Click Add New Output Result again.
In the Name control, enter Right (LC). This output will contain the results of
Equation 5-1.
10. Make sure Type is set to Numeric.
11. Click OK to close the Calculator Setup Wizard.

The Main window now displays a diagram with the measurement inputs and result outputs you
specified in the Calculator Setup Wizard, as shown in Figure 5-7. The diagram also contains a
default Boolean result named Step Result. You can connect the result of a computation to Step
Result, which changes the status of the Calculator step to the result of the computation. Refer
to the Making Logical PASS/FAIL Decisions with the Calculator Step section of this chapter for
more information about Step Result.

Figure 5-7. Calculator Diagram Elements

Find Right Edge - Edge [1].% Position (Calibrated) Step Result
.':ﬁ.'éé"[;
TF
Find Left Edge - Edge [1].% Position {Calibrated) Part width
23y Sk
Right {LC)
1251

Notice that the inputs and outputs are framed with color and have codes at the bottom of their
frames. These colors and codes visually group inputs and outputs into their respective data
types—numerics, Booleans, or strings.
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12. To simplify the process of connecting the diagram elements later in this chapter, arrange the
elements into the configuration shown in Figure 5-8 by dragging them to their new
positions.

Figure 5-8. Arranging Diagram Elements
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Adding Operators and Constants

Earlier in this chapter, you used the Calibration Wizard to set calibration axis origins for the right
and left sides of the part. These origins are the only elements of Equations 5-1 and 5-2 not yet
represented in the Calculator diagram: (Origin R and Origin L).

In step 18 of the Acquiring and Calibrating the Image of the Right Edge section of this chapter,
you set the origin of the right side to the 38 cm marking of the imaged ruler. In step 18 of the
Acquiring and Calibrating the Image of the Left Edge section of this chapter, you set the origin
of the left side to the 1 cm marking of the imaged ruler. Therefore,

(Origin R - Origin L) =38 - 1 =37.

The distance between the calibration axis origins is a constant value. Add a constant with the
value 37 to the Calculator diagram.

1.  Click the Show Functions Palette button.

2. In the Functions Palette window, select Numeric palette.

123

3.  Click the Numeric Constant.

4.  Click inside the Calculator diagram below the Find Right Edge - Edge [1].X Position
(Calibrated) input measurement to place the numeric constant on the Calculator diagram.
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5. Double-click the numeric constant and type 37 to set the value of the constant.

6. Click the Add operator in the Functions palette. Click inside the Calculator diagram to the
right of the Find Right Edge - Edge [1].X Position (Calibrated) input measurement.

[£

@ Tip Place the Add operator close enough to the Find Right Edge - Edge [1].X
Position (Calibrated) input so that the Calculator step automatically connects the
two elements with a wire.

7.  Click the Help button in the Calculator diagram toolbar to launch the Help window. When
you move your cursor over certain elements within the Calculator diagram, information
about that item shows in the Help window.

8. Place your cursor over the Add operator. Notice in the Help window that the operator has
an X input terminal, y input terminal, and x+y output terminal.

9.  Click the Subtract operator in the Functions palette. Click inside the Calculator diagram to
the right of the Find Left Edge - Edge [1].X Position (Calibrated) input measurement.

=

Your Calculator diagram should look similar to the diagram shown in Figure 5-9.

Figure 5-9. Unconnected Diagram Elements
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Connecting the Equation Elements

Complete the following instructions to wire the diagram elements together such that they form
Equation 5-1: Right (LC) = Right (RC) + (37).

1. Place your cursor on the small, triangular terminal located on the right side of the numeric
constant. The cursor changes into a Wiring tool.

2. Use the Wiring tool to click the terminal and release the mouse. As you move the cursor
across the Calculator diagram, the Calculator step draws a wire between the terminal and
the Wiring tool as though the wire were unwinding from a spool.

3. Without holding down the mouse button, move the cursor to the y input terminal of the Add
operator. The y input terminal blinks. Use the Wiring tool to click the y input terminal and
complete the connection.

4.  Click the output terminal of the Add operator, and connect it to the input terminal of
Right (LC).

@ Tip If you do not terminate a wire correctly, the wire is broken and appears as a
dashed black line with a red X in the middle. Click Remove Broken Wires in the
Main tab to remove broken wires.

Complete the following instructions to wire the diagram elements together such that they form
Equation 5-2: Part Width = Right (LC) - Left (LC).

1. Place the cursor on the wire that connects the Add operator to Right (LC). The cursor
changes into the Wiring tool.
2. Click the wire, and connect it to the x input terminal of the Subtract operator.

Click the Find Left Edge - Edge [1].X Position (Calibrated) output terminal, and connect
it to the y input terminal of the Subtract operator.

4.  Click the output terminal of the Subtract operator, and connect it to the input terminal of
Part Width.
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Your connected Calculator diagram should look similar to the diagram shown in Figure 5-10.

Figure 5-10. Connected Elements of Calculator Diagram
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In the Calculator step property page, click the Measurements tab.

Click Compute Results to see the results of the calculation thus far.

Making Logical PASS/FAIL Decisions with the
Calculator Step

Now that you have a created a diagram to measure the width of the part, you need a way to verify
that the width meets manufacturing specifications. Complete the following instructions to add
diagram elements that compare the measured width to minimum and maximum width tolerances
and decide whether the plank passes inspection.

1.
2.

e

10.

5-16

Click the up arrow in the Functions palette to return to the main palette.

Select the Comparison palette.

T

Click the Less? operator in the Comparison palette. Click inside the Calculator diagram
below Part Width.

Connect the wire between Subtract and Part Width to the x input of the Less? operator.
Click the up arrow in the Functions palette to return to the main palette.

Select the Numeric palette.

Click the Numeric Constant in the Numeric palette.

Click close enough to the y input of Less? to automatically wire the numeric constant and
y input together.

Double click the constant and type 40 . 5 to set the maximum width a plank can be to pass
the inspection.

Click the up arrow in the Functions palette to return to the main palette.
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12.
13.

14.
15.
16.
17.

18.

19.
20.
21.

22.
23.
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Select the Comparison palette.
Click the Greater? operator. Click inside the Calculator diagram below the Less? operator.

Connect the wire between Subtract and Part Width to the x input of the Greater?
operator.

Click the up arrow in the Functions palette to return to the main palette.
Select the Numeric palette.
Click the Numeric Constant.

Click close enough to the y input of Greater? to automatically wire the numeric constant
and y input together.

Double click the constant and type 39. 5 to set the minimum width a plank can be to pass
the inspection.

Click the up arrow in the Functions palette to return to the main palette.
Select the Boolean palette.

Click the And operator. Click close enough to the left side of Step Result to wire the two
elements together.

Connect the Less? output to the x input of And.
Connect the Greater? output to the y input of And.

Your completed Calculator diagram should look similar to the diagram shown in Figure 5-11.

Figure 5-11. Calculator Diagram with Decision-Making Abilities
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24. In the Calculator step property page, click the Limits tab.
25. Enable the Step Result is True checkbox.
26. Click OK to add the step to the inspection.
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Setting the Inspection Status

Complete the following instructions to add a Set Inspection Status step to determine whether
the inspection passes or fails.

1. Inthe Inspection Steps palette, select the Use Additional Tools tab.

7

2. Click the Set Inspection Status step. The property page for the step opens.

8

3. Inthe Inspection Status control, Select the Set to FAIL if any previous step fails option.
4.  Click OK to add the step to the inspection.
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Testing the Inspection

Test the inspection to make sure it returns the results you expect. Click the Run Inspection
Once button to test the remaining images. Table 5-1 lists the test images, the inspection status
to expect for each image, and an explanation of the status.

1

Note Results may vary slightly based on the accuracy of the calibration and the
edge detection location.

Table 5-1. Expected Results for the Plank Inspection

Image Name Part Width Inspection Status
Image 01.7jpg 39.99 cm PASS
Image 02.7pg 40.12 cm PASS
Image 03.7pg 40.25 cm PASS
Image 04.7pg 39.23 cm (too short) FAIL
Image 05.7pg 40.89 cm (too long) FAIL

Saving the Inspection

Complete the following instructions to save the example inspection.

1.  Select File»Save or click the Save button on the toolbar.

H

2. Navigate to the location where you want to save the inspection.

3. Inthe File Name control, enter Tutorial 4.vbai.

4.  Click Save to save the inspection.

9

Tip Select FilenInspection Properties to add a short description or comments
about the inspection.
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Branching and Decision
Making

This chapter introduces the inspection state diagram and the Custom Overlay step. Follow the
instructions in this chapter to create an inspection that checks the image for the presence of a

spray bottle and, if a bottle is present, transitions to another state to determine if the bottle has a
cap. If there is no spray bottle present in the image, the inspection moves on to the next image.

Note Launch Vision Builder Al if it is not open. Refer to the Vision Builder AI

Configuration Interface section of Chapter 1, Introduction to Vision Builder Al,
for more information.

Creating a New Inspection

Select File»New to load a new, blank Vision Builder Al inspection.

Creating the Inspection State Diagram

The configurable process model in Vision Builder Al is represented by a state diagram.

Complete the following instructions to create a state diagram to define the inspection.

1. Click the Toggle Main Window View button on the toolbar to bring the state diagram to
the Main window.

Aoy
i

Figure 6-1. Default Inspection State Diagram
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End

© National Instruments | 6-1



Chapter 6 Branching and Decision Making

2. Double-click the Inspect state to launch the Edit State Name dialog box.
In the State Name control, enter Check Part Presence, and click OK.

4. Right-click an open area on the state diagram and select Create New State to add a new
state to the inspection, as shown in Figure 6-2. The Edit State Name dialog box opens.

Figure 6-2. Creating a New Inspection State

Start

default

k Part Presgnce

default ICreate New End Point

Che

End

Import Inspection

5. In the State Name control, enter Inspect Part.

6. Create two more statesnamed Fail Part and Pass Part. The state diagram should now
resemble the state diagram shown in Figure 6-3.

Figure 6-3. Adding New States to the Inspection
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default
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default
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End

' default
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default ‘- default
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Next, you will create transitions between the various inspection states. Notice that every state
has a default transition. You can also create additional transitions between states based on
measurement results or variable values.

Note The default transition occurs if the transition requirements for other possible
transitions are not met.

7.  Click the arrow of the Check Part Presence default transition and drag it back to the Check
Part Presence state. This creates a loop that will run the steps in the Check Part Presence
State until a part is detected.

8. Click the End point and drag it to the bottom of the state diagram.

9.  Click the Inspect Part default transition and drag it to the Fail Part state.
10. Click the Fail Part default transition and drag it to the End point.

11. Click the Pass Part default transition and drag it to the End point.

The state diagram should now resemble the state diagram shown in Figure 6-4.

Figure 6-4. Configuring the Default Transitions
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12. Right-click the Check Part Presence state and select Create New Transition.
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13. Click the Inspect Part state to create a transition between the Check Part Presence and
Inspect Parts states, as shown in Figure 6-5.

Figure 6-5. Creating a New Transition

default
k Part Presgnce

Che

Transition 1

default

You can change the shape of the transition by dragging the anchor point at the center of the
transition. You can move the location of the transition label by clicking the label and
dragging it to the new location.

@ Tip When drawing a transition, click once on the state diagram to set the anchor
point for the transition. The anchor point allows you to draw an arc instead of a
straight line to represent the transition.

14. Double-click the transition to launch the Edit Transition dialog box, which is used to
configure the transition.

15. In the Transition Name control, enter Part Detected, and click OK.

16. Create another transition named Part OK between the Inspect Part and Pass Part states.
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The state diagram should now resemble the state diagram shown in Figure 6-6.

Figure 6-6. Completed State Diagram for the Inspection
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Note You can remove a state or transition from the inspection by selecting the
object you want to remove and pressing the <Delete> key.

@ Note You cannot rename or remove the default transition of a state.
Each state in an inspection is intended to contain a separate set of inspection steps. To access the

functions in a state, click the state in the state diagram. The currently selected state is highlighted
in blue on the state diagram.

Acquiring Inspection Images

For simplicity, this tutorial instructs you to use the Read Image File step. However, in your
real-world inspection, use one of the other image acquisition steps to acquire images of the
object under inspection.

Complete the following instructions to configure a Read Image File step that simulates
acquiring images of spray bottles.

Check Part Presence

17. On the state diagram, click the Check Part Presence state.
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18. In the Inspection Steps palette, select the Acquire Images tab.

19. Click the Read Image File step. The property page for the step opens.

b

\é Note When the property page for an inspection step opens, if the state diagram is
displayed in the Main window, the state diagram switches from the Main window to
the Overview window to allow you to use the current inspection image to configure
the step.

20. Inthe Step Name control, enter Acquire Image.

21. Click the Browse button. The Select an Image File dialog box opens.

22. Navigateto <Public Documents>\National Instruments\<Vision Builder
AI>\DemoImg\Tutorial 5.

\é Note Ensure that you have selected the appropriate folder if you have more than
one version of Vision Builder Al installed.

23. Select an image containing the entire spray bottle, such as Image 00480.jpg, and
click Open.

24. Make sure the Cycle Through Folder Images control is enabled so that Vision Builder Al
loads a different simulation image from the folder each time the step is run.

25. Click OK to add the step to the inspection.

Checking for a Spray Bottle in the Image

Complete the following instructions to configure a Match Pattern step to check for the presence
of a spray bottle in the image.

1. In the Inspection Steps palette, select the Locate Features tab.
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Click the Match Pattern step. The NI Vision Template Editor opens.

Draw a region of interest (ROI) around the bottom left edge of the bottle. This region
becomes the pattern matching template.

Click Next.
Click Finish to accept the template.
On the Main tab, enter Locate Bottle in the Step Name control.

Adjust the default green ROI so that it only surrounds the area of the image that could
contain the bottom left edge of a spray bottle, as shown in Figure 6-7.

Figure 6-7. Adjusting the Search Region

Locate Bottle

On the Specifications tab,
. set Number of Matches to Find to 1, and
* uncheck Rotated.

On the Limits tab, enable the Minimum Number of Matches control, and set the
value to 1.

Click OK to add the step to the inspection.
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Checking for the Cap Using the Caliper

You can check for the presence of the cap on a spray bottle by using the Caliper step to find
two edges where the cap is supposed to be and measuring the distance between them. Complete
the following instructions to configure a Caliper step to check for the presence of the spray
bottle cap.

[nspeck Park

In the Overview window, click the Inspect Part state on the state diagram.

2. Inthe Inspection Steps palette, select the Measure Features tab.

3. Click the Caliper step. The property page for the step opens.

+H+

4. Inthe Step Name control, enter Check Cap Presence.
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Draw an ROI around the area in the image where a cap should appear, as shown in
Figure 6-8.
Figure 6-8. Checking for Cap Presence

9.

| P

Check Cap Presence

On the Settings tab, select the Process named Horizontal Max Caliper to change the
direction and orientation of the caliper search lines.

APk

Set the Gap control to 10, Edge Strength to 40, and Smoothing to 12 to ensure that the
step correctly detects the edges of the cap.

On the Limits tab, enable the Minimum Distance (Pixels) control, and set the value to
140.

Enable the Maximum Distance (Pixels) control, and set the value to 160.

10. Click OK to add the step to the inspection.
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Setting the Inspection Status

Complete the following instructions to add a Set Inspection Status step to determine whether
the inspection passes or fails.

1. In the Inspection Steps palette, click the Use Additional Tools tab.

7

2. Click the Set Inspection Status step. The property page for the step opens.

8

3. Inthe Inspection Status control, select the Set to FAIL if any previous step fails option.
4.  Click OK to add the step to the inspection.

Creating Custom Overlays for Inspection

Use the Custom Overlay step to create custom overlays that display whether the inspection
passed or failed.

Complete the following steps to create an overlay to display when the inspection fails.

Fail Part

1. Inthe Overview window, click the Fail Part state on the state diagram.

2. Inthe Inspection Steps palette, select the Use Additional Tools tab.

7

3. Click the Custom Overlay step. The property page for the step opens.

m,

4. Inthe Step Name control, enter Overlay Results.

On the Custom Overlay tab, select the Text tool and click a point in the image near the
bottom of the spray nozzle of the bottle.

A
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In the Text Control, enter Missing Cap!.

Click the Text Properties button. The Text Properties dialog box opens.

A

In the Desired Font control, select User-Specified Font.
9. Specify a Font Name and Size to use for the overlay.

10. In the Horizontal Alignment control, select Center. This centers the text around the point
you selected using the Text tool.

11. Click OK to save the Text Properties settings and close the dialog box.
12. Click OK to add the step to the inspection.

Next, you need to create an overlay to display if the inspection passes. Complete the following
steps to create an overlay to display when the inspection passes.

13. In the Overview window, click the Pass Part state on the state diagram.

14. In the Inspection Steps palette, select the Use Additional Tools tab.

7

15. Click the Custom Overlay step. The property page for the step opens.
16. In the Step Name control, enter Overlay Results.

17. On the Custom Overlay tab, select the Rectangle tool and draw a rectangle in the
upper-left corner of the image.

|

18. Click the Stroke control, and select black.
19. Click the Fill control, and select a bright green color.
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20. On the Custom Overlay tab, select the Text tool, and click a point just below the center of
the rectangle overlay.

A4

21. In the Text control, enter Part OK.
22. Click the Text color control, and select black.
23. Click the Text Properties button. The Text Properties dialog box appears.

¥ |

24. In the Desired Font control, select User-Specified Font.

25. Specify a Font Name and Size to use for the overlay.

26. Inthe Horizontal Alignment control, select Center.

27. Click OK to save the Text Properties settings and close the dialog box.
28. Click OK to add the step to the inspection.

Figure 6-9 shows the overlays for both Pass and Fail images.

Figure 6-9. Creating Custom Overlays for Images that Pass and Fail

PART OK
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Configuring State Transitions

Once you have configured all of the states in the inspection and created transitions between the

states, you need to define the conditions that trigger a transition between inspection states.

Complete the following instructions to define the transitions between inspection states.

1. Click the Toggle Main Window View button to display the state diagram in the Main

window.

Aoy
i

2. Double-click the Part Detected transition to launch the Edit Transition dialog box, which

is used to configure the transition.

3. Inthe Edit Transition dialog box, modify the controls to transition when Locate Bottle - #

Matches is Equal to 1, as shown in Figure 6-10.
Figure 6-10. Configuring the Part Detected Transition

%

Transition Name
Part Detected

Transition will be activated when the following condition is met

Measurement |Locate Botte - # Matches [
iz |Egual v to 1|
Current Value: 1
oK Cancel

4. Click OK to close the Edit Transition dialog box.
Double-click the Part OK transition. The Edit Transition dialog box opens.

© National Instruments
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6.

In the Edit Transition dialog box, modify the controls to transition when Check Cap
Presence - Step Status is Pass, as shown in Figure 6-11.

Figure 6-11. Configuring the Part OK Transition

7.

& Edit Transition *

Transition Name
Part OK

Transition will be activated when the following condition is met

Measurement |Check Cap Presence - Step Status ¥

is ) Pass
Fail
Mot Available

Current Value: Pass

oK Cancel

Click OK to close the Edit Transition dialog box.

Testing the Inspection

Test the images in the Tutorial 5 folder to make sure the inspection returns the correct

results. Click the Run Inspection Once button to test the remaining images. Table 6-1 displays

the expected results for each image.

1

Table 6-1. Expected Results for the State Diagram Branching Inspection

Image Name Inspection Status Explanation
Image 00480.7jpg PASS Cap is present.
Image 01710.3pg PASS Cap is present
Image 03450.7jpg FAIL Cap is missing.
Image 04200.7jpg PASS Cap is present.
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Saving the Inspection
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Complete the following instructions to save the example inspection.

1.

2.
3.
4.

Select File»Save or click the Save button on the toolbar.

H

Navigate to the location where you want to save the inspection.

In the File Name control, enter Tutorial 5.vbai.

Click Save to save the inspection.

9

Tip Select FilenInspection Properties to add a short description or comments

about the inspection.
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Looping and Variables

This chapter uses the inspection state diagram to implement a looping inspection and introduces
the Set Variable and Array Operator steps. Follow the instructions in this chapter to create an
inspection that inspects images of electronic components to determine if the distance between
pins on the component is within a predetermined range. If the pin is too close or too far away
from an adjacent pin, then the inspection fails. The inspection does not need to check every pin
on the microchip before failing the inspection. The inspection fails at the first failed pin.

Note Launch Vision Builder Al if it is not open. Refer to the Vision Builder Al

Configuration Interface section of Chapter 1, Introduction to Vision Builder Al,
for more information.

Creating a New Inspection

Select File»New to load a new, blank Vision Builder Al inspection.

Creating the Inspection State Diagram

Complete the following instructions to create a state diagram to define the inspection.

1. Click the Toggle Main Window View button on the toolbar to bring the inspection state
diagram to the Main window.

£ o]
i

2. Double-click the Inspect state to launch the Edit State Name dialog box.

3. Inthe State Name control, enter Acquire Image & Find Pin Edges.

© National Instruments 71



Chapter 7 Looping and Variables

4. Right-click an open area on the state diagram and select Create New State to add a new
state to the inspection, as shown in Figure 7-1. The Edit State Name dialog box opens.

Figure 7-1. Creating a New Inspection State

Start

default

Acquire ImMage & Find)Pin Edges

| Crstehen Sise

default Create New End Paint

End

Import Inspection

5. In the State Name control, enter Check Pin Gap.

6. Create two more states named Fail Inspection and Pass Inspection. The state
diagram should now resemble the state diagram shown in Figure 7-2.

Figure 7-2. Adding New States to the Inspection
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default
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default

. default
&=
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‘ default

Next, you will define transitions between the various inspection states. Notice that every state
has a default transition. You can also create additional transitions between states based on
measurement results or variable values.

Note The default transition occurs if the transition requirements for other possible
transitions are not met.
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7. Click the Acquire Image & Find Pin Edges default transition and drag it to the Check Pin
Gap state.
8. Click the End point and drag it to the bottom of the state diagram.
9.  Click the Check Pin Gap state default transition and drag it to the Pass Inspection state.
10. Click the Fail Inspection default transition and drag it to the End point.
11. Click the Pass Inspection default transition and drag it to the End point.

The state diagram should now resemble the state diagram shown in Figure 7-3.

Figure 7-3. Configuring the Default Transitions
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12. Right-click the Acquire Image & Find Pin Edges state and select Create New
Transition.
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13. Click the Fail Inspection state to create a transition between the Acquire Image & Find Pin
Edges state and the Fail Inspection state, as shown in Figure 7-4.

Figure 7-4. Creating a New Transition

age & Find)Pin Edges

default

Acquire |

Transition 1

You can change the shape of the transition by dragging the anchor point at the center of the
transition. You can move the location of the transition label by clicking the label and
dragging it to the new location.

@ Tip When drawing a transition, click once on the state diagram to set the anchor
point for the transition. The anchor point allows you to draw an arc instead of a
straight line to represent the transition.

14. Double-click the transition to launch the Edit Transition dialog box.
15. In the Transition Name control, enter Wrong # Pins, and click OK.
16. Create a transition named Failed between the Check Pin Gap and Fail Inspection states.

17. Create a transition from the Check Pin Gap state that loops back to the Check Pin Gap
state named Repeat for Next Pin.
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The state diagram should now resemble the state diagram shown in Figure 7-5.

Figure 7-5. Completed State Diagram for the Inspection
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Creating a Variable

Since the same inspection needs to be performed on each set of pins, creating a loop in the
inspection eliminates the need to configure separate steps to inspect each set of pins. Use the
Variable Manager to configure a variable to keep track of the number of times the loop executes.

1. Select Tools»Variable Manager to launch the Variable Manager.

2. On the Inspection Variables tab of the Variable Manager, click Add to launch the Add
Inspection Variable dialog box.

In the Name control, enter Counter.

In the Type control, select Numeric.

In the Initial Value control, enter 1.
Click OK to create the variable.

Click OK to close the Variable Manager.

NS n AW
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Acquiring Inspection Images

For simplicity, this tutorial instructs you to use the Read Image File step. However, in your
real-world inspection, use one of the other image acquisition steps to acquire images of the
object under inspection.

Complete the following instructions to configure a Read Image File step that simulates
acquiring images of the pins on electronic components.

licquire Image & Find Pin Edges

1. On the state diagram, select the Acquire Image & Find Pin Edges state.
2. In the Inspection Steps palette, select the Acquire Images tab.

3. Click the Read Image File step. The property page for the step opens.

b

@ Note When the property page for an inspection step opens, if the state diagram is
displayed in the Main window, the state diagram switches from the Main window to
the Overview window to allow you to use the current inspection image to configure
the step.

4. Inthe Step Name control, enter Acquire Pins.

Click the Browse button. The Select an Image File dialog box opens.

6. Navigateto <Public Documents>\National Instruments\<Vision Builder
AI>\DemoImg\Tutorial 6.

Select image 01.7jpg, and click Open.

Make sure the Cycle Through Folder Images control is enabled so that Vision Builder Al
loads a different simulation image from the folder each time the step is run.

9. Click OK to add the step to the inspection.
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Finding Pin Edges

Complete the following instructions to configure a Find Edges step to find the edges of the pins
and determine if the microchip has the correct number of pins.

1. Inthe Inspection Steps palette, select the Locate Features tab.

2. Click the Find Edges step. The property page for the step opens.

-

1
[ — |

In the Step Name control, enter Find Pin Edges.

4. Hold down the <Shift> key and draw a line from left to right across the width of the image
where the pins are located, as shown in Figure 7-6.

Figure 7-6. Locating the Edges of the Pins of a Microchip

On the Settings tab, in the Look for control, select All Edges.

In the Edge Polarity control, select Bright to Dark Only.

On the Limits tab, enable the Minimum Number of Edges control and set the value to 7.
Enable the Maximum Number of Edges control and set the value to 7.

Click OK to add the step to the inspection.

O 0 N

© National Instruments | 7-7



Chapter 7 Looping and Variables

Initializing the Variable

Use the Set Variable step to set the value of user-defined variables. Complete the following
instructions to configure a Set Variable step to initialize the Counter variable.

1. In the Inspection Steps palette, select the Use Additional Tools tab.

7

2. Click the Set Variable step. The property page for the step opens in the Main window.

55

In the Step Name control, enter Initialize Counter.

4. In the Operation control, select the Set to Constant option and enter 1 for the value.
Click OK to add the step to the inspection.

Indexing Measurements in a Result Array

Complete the following instructions to configure an Array Operator step to index the x and y
position results for the ith edge, where i is the value of the Counter variable. The position results
are returned by the Find Pin Edges step in the Acquire Image & Find Pin Edges state.

//
Check Pin Gap

In the Overview window, click the Check Pin Gap state on the state diagram.
2. Inthe Inspection Steps palette, select the Use Additional Tools tab.
Click the Array Operator step. The property page for the step opens.

4. Inthe Step Name control, enter Get Edge Position.
In the Array Function list, select Index.

6. Inthe Source Array control, select the following array elements:
. Acquire Image & Find Pin Edges»Find Pin Edges»Edge [].X Position (Pixel)
*  Acquire Image & Find Pin Edges»Find Pin Edges»Edge [].Y Position (Pixel)
In the Element Index list, select Inspection Variable - Counter (1).
Click OK to add the step to the inspection.
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In the Updating the Variable section of this tutorial, you will set the Counter variable to

increment by one each time the Check Pin Gap state is run. This ensures that a different set of
pins is inspected each time the Array Operator step is run.

Setting a Coordinate System

Complete the following instructions to configure a Set Coordinate System step based on the
Find Pin Edges step you configured.

1. In the Inspection Steps palette, select the Locate Features tab.

2. Click the Set Coordinate System step. The property page for the step opens.

b

3. On the Settings tab, in the Mode control, select Horizontal Motion because the pins may
shift horizontally from one image to another.

4—4‘_.
4.  Click OK to add the step to the inspection.

Checking the Pin Gap

Complete the following instructions to measure the gap between two pins and determine if it is
within a certain range.

1. In the Inspection Steps palette, select the Measure Features tab.

2. Click the Caliper step. The property page for the step opens.

+|/|+

In the Step Name control, enter Measure Gap.

4. Enable the Reposition Region of Interest control and verify that Set Coordinate System
is selected for the Reference Coordinate System control.
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5. Draw an ROI over the gap between the first two pins, as shown in Figure 7-7.

Figure 7-7. Measuring the Distance Between Pins

6. In the Settings tab, select the Process named Horizontal Max Caliper to change the
direction and orientation of the caliper search lines.

i

7. On the Limits tab, enable the Minimum Distance control and set the value to 30.00.
Enable the Maximum Distance control and set the value to 46.00.

8. Click OK to add the step to the inspection.

Updating the Variable

After you have measured the gap between two pins, you must increment the Counter variable so
that the next time the state is executed the next set of pins is inspected. Complete the following
instructions to use a Set Variable step to increment the value of the Counter variable.

1. In the Inspection Steps palette, select the Use Additional Tools tab.

7

2. Click the Set Variable step. The property page for the step opens in the Main window.

55

3. Inthe Step Name control, enter Update Counter.

7-10 | ni.com



4.
5.

NI Vision Builder for Automated Inspection Tutorial

In the Operation control, select the Increment option.
Click OK to add the step to the inspection.

|dentifying Failed Pins

Complete the following instructions to create an overlay to identify a failed pin using the
Custom Overlay step.

1.

10.

In the Inspection Steps palette, select the Use Additional Tools tab.

7

Click the Custom Overlay step. The property page for the step opens.

O

In the Step Name control, enter Overlay Failed Gap.

On the Custom Overlay tab, select the Indicator tool and draw a small indicator on the
image.

In the Top Left Point control, select Get Edge Position - Edge [i]. This aligns the top left
point of the indicator overlay with the ith edge found by the Get Edge Position step.

In the X Offset control, enter 35. In the Y Offset control, enter 28. This positions the
indicator overlay over the gap between two pins.

In the Value control, select Measure Gap - Step Status to set the indicator overlay to
display the Step Status for the Measure Gap step in the inspection.

Delete the text in the True Text control since the overlay is only displayed if the inspection

fails. Set the Fill to transparent.

In the False Text control, enter FATL. Set the Fill to red.
Click OK to add the step to the inspection.
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Setting the Inspection Status

Complete the following instructions to set the Inspection Status for the inspection.

Y

Fail Inspection

1. Inthe Overview Window, click the Fail Inspection state on the state diagram.
2. Inthe Inspection Steps palette, select the Use Additional Tools tab.
Click the Set Inspection Status step. The property page for the step opens.

8

In the Step Name control, enter Set Inspection Status.

In the Inspection Status control, select the Set to FAIL option.
Enable the Update Number of Parts Inspected checkbox.
Click OK to add the step to the inspection.

Nk

Pass Inspection

8. In the Overview Window, click the Pass Inspection state on the state diagram.
9. In the Inspection Steps palette, select the Use Additional Tools tab.

10. Click the Set Inspection Status step. The property page for the step opens.

11. Inthe Step Name control, enter Set Inspection Status.

12. In the Inspection Status control, select the Set to PASS option.

13. Enable the Update Number of Parts Inspected checkbox.

14. Click OK to add the step to the inspection.

Displaying the Current Inspection Image

Complete the following instructions to use a Display Image step to display the current
inspection image.

Fail Inspection

1. Inthe Overview Window, click the Fail Inspection state on the state diagram.

2. Inthe Inspection Steps palette, select the Use Additional Tools tab.
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Click the Display Image step. The property page for the step opens.

By

In the Step Name control, enter Display Image.

In the Display Images control, select the Always option.
Click OK to add the step to the inspection.

In the Overview window, click the Pass Inspection state on the state diagram.

Pass Inspection

In the Inspection Steps palette, select the Use Additional Tools tab.
Click the Display Image step. The property page for the step opens.
In the Step Name control, enter Display Image.

In the Display Images control, select the Always option.

Click OK to add the step to the inspection.

Configuring State Transitions

After you have created the state diagram and configured all of the steps in the inspection, you
must specify when you want transitions from one state to another state to occur. Complete the
following sets of instructions to configure the transitions for the inspection.

If an image has an incorrect number of pins, the inspection should transition to the Fail
Inspection state. Complete the following instructions to define the Wrong # Pins transition.

1.

Click the Toggle Main Window View button on the toolbar to bring the inspection state
diagram to the Main window.

Ay
LT

Double-click the Wrong # Pins transition on the state diagram to launch the Edit Transition
dialog box.

In the Edit Transition dialog box, modify the controls to transition when Find Pin Edges -
Step Status is Fail.

Click OK to close the dialog box.
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Since the same inspection needs to be performed on each set of pins on the electronic
component, the Repeat for Next Pin transition creates a loop in the inspection that eliminates the
need to configure separate steps to inspect each set of pins. Complete the following instructions
to configure the Repeat for Next Pin transition.

1. Double-click the Repeat for Next Pin transition.

2. In the Edit Transition dialog box, modify the controls to transition when Get Edge
Position - Remaining Objects is Greater than 1.

3. Click OK to close the dialog box.

The final transition that must be defined for the inspection is the transition between the Check
Pin Gap and Fail Inspection states that occurs when the pins on the component fail inspection.
Complete the following instructions to configure the Failed transition.

1. Double-click the Failed transition.

2. In the Edit Transition dialog box, modify the controls to transition when Measure Gap -
Step Status is Fail.

3. Click OK to close the dialog box.

Testing the Inspection

Test the images in the Tutorial 6 folder to make sure the inspection returns the correct
results. Click the Run Inspection Once button to test the remaining images. Table 7-1 displays
the expected results for each image.

1

Table 7-1. Expected Results for the State Diagram Looping Inspection

Image Name Inspection Status Explanation

Image 01.7jpg PASS All pins are present and straight.
Image 02.7pg PASS All pins are present and straight.
Image 03.7jpg PASS All pins are present and straight.
Image 04.jpg FAIL Third pin is bent.

Image 05.7pg PASS All pins are present and straight.
Image 06.jpg FAIL Fifth pin is bent.

Image 07.3pg PASS All pins are present and straight.
Image 08.7pg FAIL Seventh pin is bent.
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Saving the Inspection

NI Vision Builder for Automated Inspection Tutorial

Complete the following instructions to save the example inspection.

1.

2.
3.
4,

Select File»Save or click the Save button on the toolbar.

H

Navigate to the location where you want to save the inspection.

In the File Name control, enter Tutorial 6.vbai.

Click Save to save the inspection.

9

Tip Select FilenInspection Properties to add a short description or comments

about the inspection.

© National Instruments
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NI Services

NI provides global services and support as part of our commitment to your success. Take
advantage of product services in addition to training and certification programs that meet your
needs during each phase of the application life cycle; from planning and development through
deployment and ongoing maintenance.

To get started, register your product at ni.com/myproducts.

As a registered NI product user, you are entitled to the following benefits:
*  Access to applicable product services.
*  Easier product management with an online account.

*  Receive critical part notifications, software updates, and service expirations.

Log in to your MyNI user profile to get personalized access to your services.

Services and Resources

*  Maintenance and Hardware Services—NI helps you identify your systems’ accuracy and
reliability requirements and provides warranty, sparing, and calibration services to help you
maintain accuracy and minimize downtime over the life of your system. Visit ni . com/
services for more information.

—  Warranty and Repair—All NI hardware features a one-year standard warranty that
is extendable up to five years. NI offers repair services performed in a timely manner
by highly trained factory technicians using only original parts at an NI service center.

—  Calibration—Through regular calibration, you can quantify and improve the
measurement performance of an instrument. NI provides state-of-the-art calibration
services. If your product supports calibration, you can obtain the calibration certificate
for your product at ni.com/calibration.

*  System Integration—If you have time constraints, limited in-house technical resources, or
other project challenges, National Instruments Alliance Partner members can help. To learn
more, call your local NI office or visit ni.com/alliance.
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*  Training and Certification—The NI training and certification program is the most
effective way to increase application development proficiency and productivity. Visit
ni.com/training for more information.

—  The Skills Guide assists you in identifying the proficiency requirements of your
current application and gives you options for obtaining those skills consistent with
your time and budget constraints and personal learning preferences. Visit ni . com/
skills-guide to see these custom paths.

— NI offers courses in several languages and formats including instructor-led classes at
facilities worldwide, courses on-site at your facility, and online courses to serve your
individual needs.

*  Technical Support—Support at ni . com/support includes the following resources:

—  Self-Help Technical Resources—Visit ni.com/support for software drivers and
updates, a searchable KnowledgeBase, product manuals, step-by-step troubleshooting
wizards, thousands of example programs, tutorials, application notes, instrument
drivers, and so on. Registered users also receive access to the NI Discussion Forums
atni.com/forums. NI Applications Engineers make sure every question submitted
online receives an answer.

—  Software Support Service Membership—The Standard Service Program (SSP) is a
renewable one-year subscription included with almost every NI software product,
including NI Developer Suite. This program entitles members to direct access to
NI Applications Engineers through phone and email for one-to-one technical support,
as well as exclusive access to online training modules at ni . com/
self-paced-training. NI also offers flexible extended contract options that
guarantee your SSP benefits are available without interruption for as long as you need
them. Visit ni.com/ssp for more information.

*  Declaration of Conformity (DoC)—A DoC is our claim of compliance with the Council
of the European Communities using the manufacturer’s declaration of conformity. This
system affords the user protection for electromagnetic compatibility (EMC) and product
safety. You can obtain the DoC for your product by visiting ni.com/certification.

For information about other technical support options in your area, visit ni.com/services,
or contact your local office at ni.com/contact.

You also can visit the Worldwide Offices section of ni.com/niglobal to access the branch
office websites, which provide up-to-date contact information, support phone numbers, email
addresses, and current events.
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Glossary

C

coordinate system

D

data type

F

field of view

focal point

inspection

intensity

M

match score

object

A reference location (origin) and angle in an image that ROIs can relate
to when positional and angular adjustments of the ROI are necessary.
A coordinate system is depicted by two lines representing the orientation
and direction of its two axes.

A format for information. Acceptable data types for most functions are
numeric, array, and string.

The area of inspection that the camera can acquire as an image.

The pixel location in a pattern matching template whose coordinates are
returned as the location of a match in the inspection image.

A vision inspection application created in and run from Vision Builder
Al that can perform inline or offline visual inspections.

The gray-level value of a pixel in a grayscale image.

A number ranging from 0 to 1,000 that indicates how closely an area of
an acquired image matches the template image. A match score of 1,000
indicates a perfect match. A match score of 0 indicates no match.

A connected region or grouping of pixels in an image in which all pixels
have intensity levels in the same range.
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Glossary

P

pattern matching

pixel

R

resolution

ROI

S

spatial calibration

state

state diagram

step

T

template

transition

G-2 | ni.com

The technique used to quickly locate a grayscale template within a
grayscale image.

Picture element—The smallest division that makes up a digital image.
For measurement tasks, optimum pixel dimensions are square (aspect
ratio of 1:1, or the width equal to the height).

The number of rows and columns of pixels. An image composed of
m rows and n columns has a resolution of m x n.

Region of Interest—An area of the image that is graphically selected
from a window displaying the image. This area can be used to focus
further processing.

Assigning physical dimensions to the area of a pixel in an image.

A particular set of steps that execute under certain conditions during an
inspection.

A graphical representation of a finite state machine.

A component of a Vision Builder Al inspection that performs a specific
visual inspection task or supporting tasks, such as decision making and
serial communication.

Pattern that you are trying to match in an image using the Match Pattern,
Match Color Pattern, Geometric Matching, or Detect Defects steps. A
template can be a region selected from an image or it can be an entire
image.

Event that causes the inspection to move from one state to another.
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